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ABOUT THIS MANUAL

About This Manual

This manual provides comprehensive instructions on all aspects of setup,
configuration and operation of Zephyr™ Performance Systems PSM
(physiological status monitoring) training hardware and Zephyr™ OmniSense™
software.

This is an interactive PDF document.
When viewing online, use the panel on the left to navigate.

The section titles will expand to show sub-topics when you click on them. The
section currently viewed is highlighted in blue and you will be relocated to the
selected section.

CONTENTS
ABOUT THIS MANUAL
GETTING STARTED

SYSTEM OVERVIEW
> The PSM System
> OmniSense™ Web Portal

> Hardware Components

The table of contents and index entries are also hyper linked - just click on
them to relocate.

When browsing, you may find it easier to use the View > Page Display > Two
Page Scrolling view.

Zephyr=Performance Systems

Madttronic

@ Note

For brevity, some operations within the software are not explicitly described;
for example, Save, Cancel and OK buttons where they are used. Their function
is widely understood, and need not be described repeatedly. Any Delete
operation is preceded by a dialog confirming that the user does want to delete
anitem.
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LIVE OPERATIONS = Shipping List

ANALYSIS OPERATIONS Match all items on the shipping list with those physically received.

ANALYSIS IMPACT

PROCESSING Item Description

ANALYSIS REPORTS Medtronic
LOG DATA

Medtronic USB Drive

OMNISENSE™ WEB PORTAL

= Contains the OmniSense™ Software Installer and soft copies of
OMNISENSE™ MOBILE documents, including the Reference Manual (this manual).
OMNISENSE™ TOOLS

BASELINE FITNESS TESTING
FITNESS PARAMETERS

Item Description

BioModule(s)
APPENDICES

EULA
SUPPORT

INDEX Garment - compression shirt/
sports bra

Description

q Garment - Zephyr™ strap

= Optional, multiple sizes available.

Item Description

0 GPS Receiver
.

= Optional

Description

BioModule charge cradle, 5 devices

= Single charge cradles also available.

Iltem Description

BioModule charge case, 50 devices

= USB connector and internal battery charge cable included.

Description

% GPS charge cradle, 5 devices

= Wall charger and USB connector included.
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Q LoRa Gateway

ANALYSIS IMPACT ]
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LOG DATA
OMNISENSE™ WEB PORTAL

= External power supply adapter
= 2.4 GHzdipole antenna
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OMNISENSE™ MOBILE

OMNISENSE™ TOOLS
BASELINE FITNESS TESTING » Ethernet cable
FITNESS PARAMETERS

= 915 MHzdipole antenna

APPENDICES
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INDEX
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GETTING STARTED
Software Installation (1/13)

Applicable Version

This manual describes operations for version 6.0 of the OmniSense™ software.

Recommended System Requirements

To check PC specifications:

1. Select Start > Computer

2. Right-click Computer

3. Select Properties

|
Computer
Open

Control Panel (NG

s
Devices and Pri 5 TortoiseSVN
W Scan for threats...

Map network drive...

Show on Desktop

Rename

Properties

Disconnect network drive..,

Operating system

System Component | Description

Windows 10

CPU

64 bit 2.8 GHz dual core or higher

RAM Greater than 8 GB; 16 GB recommended
Hard drive 500 GB SSD recommended
USB ports Three ports, or one port able to support a USB hub

If using 50-Bay: Seven ports, or one port able to
support a USB hub

All ports USB 2.0 or higher

Graphics card

NVIDIA™* or Radeon™*

Screenresolution

1024 x768

Touchscreen recommended

Bluetooth™*

v2.1 + EDR orlater

Framework

Microsoft™* NET 4.x

Warning

Do not connect any Zephyr™ hardware to your PC until after the driver files are
installed automatically as part of the OmniSense™ software installation.

Warning

Do notinstall any Zephyr™ software on an Apple™* computer using a virtual PC
interface, and then connect a BioModule to the computer via USB. The device
may behave unpredictably during subsequent operations.
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Installed Components

The following components will be installed.

System Component Description

Microsoft™* .NET3.5/SP1 & 4.0

Program framework required to operate the
application software (already embedded in
Microsoft™* Windows™* 7)

Zephyr™ USB Driver

Files needed to communicate with Zephyr™
hardware when they are connected directly
toaPC

Firebird Database

Database for storing recorded physiological
data (this doesn't show up in the Add/
Remove programs page in Microsoft™*
Windows™%)

Module

Zephyr™ OmniSense™ Live

Zephyr™ Application Software

Zephyr™ OmniSense™
Analysis Module

Zephyr™ Application Software

Zephyr™ Configuration Tool

Configuration Tool for Zephyr™ BioModules
(to be used only after consultation with
Zephyr™ or distributor)

Zephyr™ Downloader

A utility for importing log files from multiple
BioModules simultaneously. Data can be
sent to the OmniSense™ database and/or
external csv files

ZUSBUpdater

Tool for updating BioModule firmware

Shortcuts for OmniSense™ Live and OmniSense™ Analysis will be installed on

the PC desktop.

gmnisenses
Analysis

Tools can be accessed from the Start Menu.

WebEx Network Recording Player
. WebEx Productivity Tools

Zephyr

A BioHamess Log Downloader

™

I OmniSense Analysis

ﬁl Uninstall OmniSense
Bluetooth BioHarness SDK

1

OmniSense Live

OmniSense Tools

Back

Computer
Control Panel
Devices and Printers

Default Programs

Help and Support
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GETTING STARTED
Software Installation (3/13)

Installation Procedure
1. Browse theinstallation files at their location — either on CD, removable
storage or on the PCitself.

= Een =
@vv‘ « Omn... » Omn.. ¥ + |42 ][ Search omnis.. P
Organize Includeinlibrary = » %~ 0 @

Documentation
DotMetFX355P1
DotMNetFX40
Firmuware Update
Motorola Scanner Drivers
Windowslnstaller_1
Windowslnstallerd_5
OrninSense 5.0 Release Notes Dec 2017 pdf
&l omnisenseZip.exe
Lysetup.exe
Ezephyrico

11 items

2. Double-click the Setup.exe file to start the installation. Do not click any
other file, as setup.exe initiates Microsoft™*.NET, Zephyr™ USB driver
and OmniSense™ software installation.

3. A Microsoft™*.NET Install dialog will display if you do not already have this
component installed on your PC. (If using Microsoft™* Windows™* 7, you
will not see this dialog as Microsoft™*.NET is already embedded).

S Ovoitese teve S =]

Foo 1 Forbermirng orrpuirionts

NET Framework 3.5 SP1

Flease seas the faloweng koense birement Press The page diwn Hey 1o see e feat
of the agreement

MICROSOFT SOFTWARE
SUPPLEMENTAL LICENSE TERMS

|MICROSOFT .NET FRAMEWORK 3.5 SP1 FOR
MICROSOFT WINDOWS OPERATING SYSTEM

[F]] View EULA for parting
Do you accopt the terms of the ponding License Agrooment 7

¥ yonu chooss Dont Accept. st wil closs To inetal you must scoet tha
remert

Accept Dont Accept

4. Click Accept to continue.

5. Some copying file dialogs will briefly display, followed by a progress bar.
You may see a User Account Control dialog to approve the installation.

1A Instaling NET Framework 3.5 SP1
'Y

L -

6. This will be followed by another dialog.
I-Micrm-ofl Windows ‘ X

Please wait while Setup configures the components. This might take several
minutes,

L ; ca ncel ]

10
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GETTING STARTED
Software Installation (4/13)

7. Youmay be asked to reboot your PC before proceeding.

‘L) OmniSense Setup -

4 Satup must mboot before procesding

Yas Na

8. Select Yes. Reboot your PC and the install process will continue
automatically. The OmniSense™ installer dialog will display automatically.

15 OmniSense 6.0.0 Setup - X

| h
Z P Welcome to the OmniSense 6.0.0 Setup
2 Wizard

The Setup Wizard will instal OmniSense 6,0.0 on your
computer, Click Next to continue or Cancel to exit the Setup
Wizard,

9. Select Next to continue. An end-user license agreement will display.
Check the ‘l accept...' box and select Next to continue.

15 OmniSense 6.0.0 Setup - X
End-User License Agreement r
Please read the following license agreement carefully e

PLEASE READ THIS END-USER LICENSE AGREEMENT
("EULA") CAREFULLY. BY INSTALLING OR USING THE
SOFTWARE THAT ACCOMPANIES THIS EULA
("SOFTWARE"), YOU AGREE TO THE TERMS OF THIS EULA.
IF YOU DO NOT AGREE, DO NOT USE THE SOFTWARE AND,
IF APPLICABLE, RETURN IT TO THE PLACE OF PURCHASE
FOR A FULL REFUND.

1. GENERAL. This EULA is a legal agreement between
you (either an individual or a single entity) and Zephyr
Technology Corporation ("Zephyr”). This EULA governs ,

11 accept the terms in the License Agreement

Bt Bk ol

10. Browse and select an alternative location for the files if needed.

2 OmniSense 6.0.0 Setup - pd
Destination Folder __
Zephyr
Click Next to install to the default folder or dick Change to choose another.

Install OmniSense 6.0.0 to:

|C: \Program Files (x86)\Zephyr\OmniSense\

Change...

Create a shortcut for this program on the desktop.

Install language packs

11
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11.

13.

Click Next to continue, unless a location other than the default is
preferred. Record where this alternate location is for future reference.
A dialog willindicate the installer is ready to start. Click Install to
continue.

1 OmniSense 6.0.0 Setup - X

| I——
Ready to install OmniSense 6.0.0 Zephyr

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard,

Back Tnctal Cancel

A progress bar will display during installation. There may be a short delay
before it initiates.

15 OmniSense 6.0.0 Setup - X
 F—
Installing OmniSense 6.0.0 Ze;hyl"
Please wait while the Setup Wizard installs OmniSense 6.0.0.
Status: Registering product

Bac Next Cancel

If an existing OmniSense™ database file (from a previous installation) is
detected, a dialog will ask whether you want to add the data from this
existing file into the new database. If you select No, the old database
file will be overwritten. If this is done in error, contact Zephyr™ for
information on recovering the overwritten data.

OmniSenze Installation T

=% Installer has found an existing database file, do you want to load the old
| data in that file into the new installation?
If you select YES, all existing data will be transferred.
If you select NO, all existing data will be lost (i.e. Hardware, Users,
Teams, etc)

12
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GETTING STARTED
Software Installation (6/13)

14. Afirmware upgrade may be required for BioModules and Motorola™*
XTS™* Speaker Microphones.

An additional directory [BioModule Firmware Upgrade] supplied on the
CD or download contains all the files needed for the user to perform the
upgrade themselves. Firmware upgrade instructions are also included in
an Appendix at the end of this manual.

OmniSense Installation X

MOTE: If you are upgrading from a previous version of
OmniSense PSM Responder you MUST upgrade all your
= firmware on existing hardware [RID and BioModules).

To do this you must open the directory of the OmniSense

Installer {this is usually the Zephyr OmniSense USE Drive } and
locate the BioHarness Firmware Upgrade directory for files
and instructions,

If you are using PSM Training ISM BioHarness modules, then
no firmware upgrade is needed.

15. Click Finish to complete the installation.

45 OmniSense 6.0.0 Setup — X

|
7 i Completed the OmniSense 6.0.0 Setup
R Wizard

Click the Finish button to exit the Setup Wizard.

16. Shortcuts for OmniSense™ Live and OmniSense™ Analysis will be placed
on your desktop.

17. Install your license key when requested on first operation of the software.
This key will be valid for subsequent updates.
B Welcome to Analysis 4

Thank you for evaluating Analysis. To purchase Analysis contact
| phyranywhere com or call (+1) 443-569-3603.

You are on day 1 of your 30 day evaluation

© it irse £

Note:

Customers are advised to keep a record of the license key, should they need
toinstall the software on a different computer at any time in the future.
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Troubleshooting

After install, some users may see overlapping of screen components:

Numbaor Of Usors:
Enable Safety Alarm Limits

OmniSense Hardware Setup Wi
| Step 10f5 ﬁ
1 2 3 4 5

Wlhat de sinin arant b An?
@ Aclid hardwara to sustam
Edit existing hardware

Next Canc

1. Right-click on the desktop and select Display Settings from the context
menu

2. In Advanced Display Settings, select Advanced sizing of text and other
items.
& Settings

€03 ADVANCED DISPLAY SETTINGS

Identify Detect

Resolution

1366 = 768 (Recommended)

Related settings
Colour calibration

ClearType text

Advanced sizing of text and other items

Display adapter properties
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Custom sizing options X

APPENDICES
To change the size of all items on the desktop, select a
EULA percentage from the list.

Scale to this percentage of normal size: _100% v

SUPPORT
INDEX

] 1 2 3

9 point Segoe Ul.

e

5. Note that the above scaling factor is not the same as that set in the initial
Display Settings dialog.
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License Key

For OmniSense™ 4.x, 5.x, and 6.x a license key must be purchased with the
software. A license key dialog will appear the first time you run OmniSense™
Live or Analysis.

w Install OmniSense Live License lé

To install a license. enter the key you received on purchasing OmniSense Live
and click OK.

License Key  XXXX- XXX -XHKHKK-XXKHK XK -XXXK-KHKHKXK-XXXX

r

| Cancel I ok

Y —

A 32-character license key will be supplied for all new instances of
OmniSense™, or upgrades, purchased.

Note

Licenses purchased for a specific iteration of OmniSense™, e.g. 6.x, are not
valid for any of the other iterations.

@ Note

Use of the OmniSense™ Web Portal, and connecting the PC software to
the portal, is a subscription service which will be administered by the user’s
Account Administrator. The license will need to be renewed annually.

End-users wishing to use the portal must be created by the Account
Administrator or a user with appropriate permissions.

The creation process will send an automatic email to the end-user’'s nominated
email address, through which they can log in to the portal and validate their
membership. See the OmniSense™ Web Portal section for more information.
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Motorola™* Barcode Scanner Support

Support is included for optional Motorola™*Barcode scanners for rapid
deployment of teams, subjects and components. Driver files for these
scanners must be installed independently.

Motorola™* DS4208

1. Browse the OmniSense™ installation files to locate the Motorola™*
Scanner Drivers directory, and then the driver file installer (32 bit or 64 bit)
appropriate for your system. Double-click the installer file to initiate.

"' User Account Control

; i’.u Do you want to allow the following program from an
"%/ unknown publisher to make changes to this computer?

Program name:  Motorola_CoreScanner_Driver_(64bit)_v2.05.0001.exe

Publisher: Unknown
File crigin: Hard drive on this computer
V| Show details Yes | | No

If a User Account Control dialog displays, select Yes to continue.

2. Theinstallation wizard will start.

[ Motorola CoreScanner Driver (64bit) - InstallShield Wizard

g Motorola CoreScanner Driver (64bit) Setup is preparing the
L™"1 InstallShield Wizard, which will guide you through the program
setup process. Please wait.

Preparing to Instal...
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3. Select Next to continue.

‘Metorols Installation Wizard ===

Motosolas CoreScanner Deiver

4. Leave Complete checked. Select Next to continue.

Measeals Inseallation Wisard [

Please 1alsct 3 sehm e

4 progpern fssures el be ol Flecues the st ik 3pace |

el vahich progam eshuess you wan instabed Recommended b advaroed

« fack Bt > Carcel

5. SelectInstall to continue.
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6. Theinstallation will proceed automatically.

Meagesla Installation Wezard [

Misdoends CoveSeanne Drivet (G484 = canfiouen po new coltviam mutalsion,

7. Select Finish to complete the install.

Meterols Installation Wizard

InslaliShield Wirsed Complete

Septugy huss frishee] ataling Motorola Conscannes Drre [Fdbi) on pous comgre,
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Hardware Installation

A PSM Training system is supplied with a charging and configuration cradle
capable of holding one, five or fifty BioModules.

In order to communicate with and download logs from each BioModule to the
PC platform, driver files must be installed for each of these devices. The best
way to do this is to remove ALL BioModules from the cradle before its first
connection to the PC, and relocate them one at a time, pausing for device

driver files to load for each.

1. Install OmniSense™, and remove all devices from the USB charge cradle

or system case.

2. Connect the empty cradle case to the PC by USB connector.

3. Replace the devices one at a time and allow the drivers to load.

‘M Installing device driver software % *
= Click here for status.

. Zephyr USB Device
Device driver software installed successfully.
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The PSM System

L/

BioModule

(Impact 0.88 ws 10w 1289.6 Calories| . .
OmniSense™ Live

| %HR MAX 87 :
HR BR i {

160" 35 = |
is V,Mi‘ ==
(— ( [) b - | ‘..L'.;, =L
099, Dennis Phillips | R1

z ™ Analvsi

Live Physiological & Omritense i
. ; o

Biomechanical Data

OmniSense™
Web Portal

The PSM System transmits live physiological data from up to 240 subjects
via aradio link to a remote PC station.

Subjects can also transmit to and view data on a mobile device application.

OmniSense™ Live and Analysis PC modules can receive and analyze
transmitted data.

Users with subscriptions to an OmniSense™ web account can view and
analyze data from either a connected PC using the OmniSense™ cloud
portal or mobile device session.

BioModules can also log data during an offline session, for later upload to a
PC via OmniSense™ Analysis

Live data is displayed in OmniSense™ Live on a configurable BioGauge,
including:

Heart Rate = Breathing Rate = Orientation
Activity Level = Estimated Core = Training Intensity
Temperature
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Zephyr™ PSM Training features:

EEETBICES . Remqte rglayofr_nultiple _ = Support of up to 240 subjects
physiological & biomechanical

EULA parameters, including
SUPPORT - Heart Rate = Optional GPS Speed & Distance,

and Map display with supported
Bluetooth™* GPS

= Range of up to 10 miles

INDEX = Breathing Rate

= Activity Level

= Estimated Core Temperature
= Subject Orientation

= OmniSense™ Live streamingdata = Baseline fitness tests

display
= Visual sweep scale and color- = Training Plan Workouts, pushed
coded display, fully configurable automatically to mobile devices

Red/Orange/Green subject status = Offline datalogging on the
algorithms BioModule

Full data recording and display
using OmniSense™ Analysis

= Fitness and Training Reports

22




CONTENTS
ABOUT THIS MANUAL
GETTING STARTED

>The PSM System

> Hardware Components
SYSTEM SETUP
LIVE OPERATIONS
ANALYSIS OPERATIONS

ANALYSIS IMPACT
PROCESSING

ANALYSIS REPORTS

LOG DATA

OMNISENSE™ WEB PORTAL
OMNISENSE™ MOBILE
OMNISENSE™ TOOLS
BASELINE FITNESS TESTING
FITNESS PARAMETERS
APPENDICES

EULA

SUPPORT

INDEX

SYSTEM OVERVIEW

OmniSense™ Web Portal (1/2)

OmniSense™ Web Portal

e -
Wi-Fi/ Cell
network Secure Cloud e = —
Database  frrereee =
Internet connection e '__H .
[Tocarpc | [ =l
2Lt OmniSense™ Web Portal
Mobile w
Application LoRa Gateway
! =
Bluetooth™* } o
Low Energy
: LoRa i
’ i PC Application
. > 7 =
RO BioModule User Nama
Password
OmniSense™ Live & Analysis tm"m'::bm S
Cloud connection dialog e
Login Close

OmniSense™ 6 now includes access to a web portal, and secure storage of data
in a cloud database.

= Connection to the portal and cloud server is available via a toolbar button in
either Live or Analysis.

= Customers must be members of an account and have a login and account
number supplied by their Account Administrator.

= Datais uploaded automatically from a connected Live session.

= Data cannot be downloaded from the Cloud server to a local PC database —
upload only is permitted.

= Data can be viewed and analyzed via a web version of OmniSense™
Analysis.

= Datais uploaded automatically from the OmniSense™ Mobile Application to
the cloud server.

If a user wants to withdraw from acceptance of terms or wants their own user
profile and data permanently deleted from the database for any reason, they
can send a written request by email to support (zephyrperformancesupport@
medtronic.com) originating from the email address associated with the user
account. If the user profile is shared between multiple customer accounts, it
must be specified which account’s data (or all) should be deleted or retained.
The support team will complete the action and send a reply email to the user to
confirm completion.
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OmniSense™ Web Portal (2/2)

OmniSense™ Cloud Account Definitions

Account

Term Description

Client name for each customer.

Subscription Fee

Each account will have an affiliated monthly fee for
each System, Administrator and Subject.

Subjects

Number of users of the system that are being
monitored. Subjects can only view their own data,
unless granted permissions. Some user types have
wider permissions (e.g. Coaches).

Administrators

Number of back-end Admins who will have access to
the data and who will be able to define who actually
sees all, some or none of the data.

Customized or standardized graphs, spreadsheets
or trends which are downloaded from the customer’s

Reports data and sent to customer based upon their viewing
contract. For example - five reports pulled for training
loads weekly.

Medtronic product such as the straps, BioModules,

Hardware gateways, etc. that make up the performance

monitoring solution.

OmniSense™ Local

Local version of OmniSense™ running on a host PC.

SLA

Service level agreement that is based on a per hour or
annual basis.

Training

On-site Zephyr™ professional support for new
customers learning the system.

For a complete description on how to use the web portal, refer to the
OmniSense™ Web Portal section.
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Hardware Components (1/5)

BioModule and Zephyr™ Strap

o ([

e )

= Connectivity = Internal algorithms for
= LoRa transmitter module = Subject ROG (Red/Orange/

Green) status
* Bluetooth™* + Bluetooth™* Low .
. = Estimated Core Temperature
Energy transmitter module

. = Jump & Dash Tests
USB for PC configuration - Heart Rate Variability

= Internal data logging, up to 450 = 250HzECG
hours*

= Logdownload by USB or = 100 Hz 16g 3-axis accelerometer
Bluetooth™*

= Battery duration up to 35 hours = Capacitive breathing detection
= 3 hour battery charge time = Supports Bluetooth™* GPS

= |P67 water resistant = Barcode labelling for rapid
deployment

= Configurable firmware

*Dependent on log format
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LIVE OPERATIONS

ANALYSIS OPERATIONS \_/
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Strap Loose Shirt Front Mount  Rear Mount Rear Mount
LOG DATA Compression Shirts Sports Bra (Femnale)
OMNISENSE™ WEB PORTAL
OMNISENSE™ MOBILE Zephyr™ Strap
™

OMNISENSE™TOOLS - Left side BioModule location - Fabric-based
BASELINE FITNESS TESTING .

= Integrated ECG & capacitive = Detachable shoulder strap
FITNESS PARAMETERS breathing sensors
APPENDICES = Adjustable, elasticized = Machine washable (replace after
EULA ~80 washes)
SUPPORT .

Loose Shirt

INDEX

= Left side BioModule location = Quick Dry

= Integrated Zephyr™ strap with = Machine washable

low profile buckle

= Flame resistant = Male & female options

= Semi-fitted athletic style

Compression Shirt Front Mount

= Center chest BioModule location = Polyester Lycra body
= Integrated ECG sensor only = Integrated GPS pocket
= Tightfit

Compression Shirt or Sports Bra Rear Mount

= Rearfacing BioModule between = Polyester/Spandex body
shoulder blades for protection

= Compression top = Neoprene pad behind BioModule
cup
= Stretchable, protected internal = Stainless steel rivets & snaps
wiring

= Compression shirt

= Unisexdesign
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ANALYSIS OPERATIONS \
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ANALYSIS REPORTS ’

LOG DATA

OMNISENSE™ WEB PORTAL

OMNISENSE™ MOBILE LoRa Gateway

OMNISENSE™ TOOLS LoRa Gateway

BASELINE FITNESS TESTING

FITNESS PARAMETERS = External power supply adapter for power

APPENDICES = 10 mile range (line of sight)

EULA = Indoor and outdoor setup options

SUPPORT

INDEX 50 BioModule Charge Case

50 BioModule Charge Case

= 50 BioModule capacity

= USB connectivity to PC, 10 BioModules at a time
= BioModule configuration

= Log download via USB or Bluetooth™*

= External power or internal rechargeable battery

= Tough, durable storage and transportation for BioModules
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= 5BioModule capacity = Logdownload via USB or Bluetooth™*

= USB mini connectivitytoPC = External power pack supplied

APPENDICES GPS

EULA
SUPPORT
INDEX

QSTARZ 818XT Charge Cradle

= Add sensor by Bluetooth™* = Supports streaming map display in
in OmniSense™ Live OmniSense™ Live

= Speed, distance travelledand = KML file export from OmniSense™
location Analysis

Note:

When using the OmniSense™ Mobile application, speed and location data is
acquired via the GPS module native to the mobile device.
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Hardware Components (5/5)

Barcode Scanner

Motorola™* DS4208 wired scanner OmniSense™ Live Rapid Deployment Tool

= AssignBioModules & GPSto = Integrated toolin OmniSense™ Live

subjects
= Assign subjects to teams = Usedevicelabels or printed sheets
= Start Live operations = Wired (DS4208) scanner support
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Setup Checklist

Prior to Live operations, the following tasks should be completed using the
OmniSense™ Live Setup screens, and Live Preferences.

Task Description

> BioModule Configuration
> Charge Devices

> Radio Network Options

> Set Radio Network Type

> OmniSense™ General
Preferences

> OmniSense™ Live Setup
Overview

> Subjects

> Safety Alarm Limits

> Devices

> Set Garment Type

> Teams

> Barcode Scanner Operations

> BioModule Operation
LIVE OPERATIONS
ANALYSIS OPERATIONS

ANALYSIS IMPACT
PROCESSING

ANALYSIS REPORTS

LOG DATA

OMNISENSE™ WEB PORTAL
OMNISENSE™ MOBILE
OMNISENSE™ TOOLS
BASELINE FITNESS TESTING
FITNESS PARAMETERS
APPENDICES

EULA

SUPPORT

INDEX

Charge devices

Ensure BioModules & GPS units
have sufficient battery charge.

Radio Network Type

Set Radio Network Type in Live
Preferences.

Set LoRa Mode.

Configure BioModules

Set log format to

Summary + Waveform or
Enhanced Summary + Waveform
if GPS devices are to be used, or
waveform data is required.

Subjects = Add subjects to database.

= AddBioModules & GPS devices to
Hardware database.

= Assign hardware to subjects.

= Createteams.
Teams = Populate teams with subjects.

Deploy teams to live when ready.
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BioModule Configuration (1/2)

Default BioModule Configuration
The default settings for newly shipped BioModules are:

Setting Value

Bluetooth™* Enabled

LoRa Enabled

Bluetooth™* Low Energy (BLE) Enabled

Log Format Enhanced Summary
LoRa Network Address

BioModules in a LoRa system each have a unique LoRa Network Address. There
must be no duplicate addresses in any one system. When adding additional
BioModules to an existing system, it may be necessary to change the LoRa
Network Address.

Addresses are usually in sequences (1, 2, 3...), but may be any values in the
range limit for the system (1-240), as long as there are no duplicates.

Note:

When configuring a LoRa system, it is good practice to label the BioModules
with a sticker indicating the LoRa Network Address.

4

Zephyr™ production BioModule labelled 24-001. LoRa Network Address is 001.
Log Format

The default log format is Enhanced Summary. For a detailed description of
all log formats and parameters, refer to Appendix 3 BioModule Log Data
Descriptions.

GPS Data

To log GPS data internally in the BioModule, the log format must be changed to
Summary & Waveform, or Enhanced Summary & Waveform.

Note:

To change BioModule default configurations, refer to the OmniSense™ Tools >
Zephyr™ Config Tool section.

[ Zeaiys Corty Tomt 310
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BioModule Configuration (2/2)

LoRa Transmission Power Level

Transmission power level is preset according to the destination region for the
device. These settings are required to comply with local regulations.

U |

Region Maximum LoRa RF Power Level (dB)

20 |

LoRa transmission power level is set using the Zephyr™ Config Tool.

Bluetooth  Poling  Subject Info
® Us
MNetwork Address 240

Number of
Downlink Channels

Downlink channel 02
Seperation

Downlink Channel 924 6
Start Frequency

MNumber of Uplink 1
Channels

Uplink Channel 0.2
Seperation

Uplink Channel 924 6
Start Frequency

Transmit Power 20

Spreading Factar 10

User Corfig  Time  Accelerometer ECHO LORA

= MHz
= MHz
= MHz
= MHz
<! dBm

Update LoRa Conrfiguration
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Charge Devices

Charge Devices

LoRa gateways are powered by an external power supply adapter.

5-device cradle 50-device case Single charge cradle

USB wall External PCor USB
charger 110/220 Volts power source

A 50 BioModule Charge Case with its internal battery can charge BioModules
for two charge cycles.

50-Device
Charge Case BioModules
Internal Battery

1 hrto 90% 1 hrto90%
3 hrsto 100% 3 hrsto 100%

Charge Times

Battery Care

For all batteries - BioModules, 50-Device Charge Case Internal Battery
= Top-up charge when not in use, around once per month.

= Top-up charge BioModules after use. Repeated shallow charges will
maintain battery condition better than less frequent deep charge cycles.

= Charge and store the devicesin a cool place.

BioModule Battery Duration

Transmitting 20 hrs

Mode Typical Battery Duration (new battery)

Logging 35hrs
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> Subjects
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Set Radio Network Type (2/2)

Set LoRa Mode
EaE a8
i ¥ G ion Settinas
Markers Radio Network Tvoe LoRa
LoRa Mode LoRa 240x15
Session ¥ General Aoplication Settinas
Displav units in Imperial
Gauge Alarms audible Yes
Show Comms Events Yes
L Show ROG Time Yes

If Radio Network Type is set to LoRa, set the LoRa Mode.

1. Inthe Preferences dialog, select the LoRa Mode option using the pull-
down menu.

LoRa Mode Description

‘ 240x15 ‘ Up to 240 devices; 15 second data reporting ‘

Caution:

LoRa Network Addresses configured into BioModules must be appropriate
for use in LoRa mode. Thus, for LoRa Mode 240x15, addresses must be in the
range from 1 to 240, with no duplicates.

Note:

Data is logged internally in the BioModules once per second (more often for
waveforms).
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OmniSense™ General Preferences (1/2)

General Preferences

Preferences other than General Settings are described in other sections.

Click on the Preferences button in the Live toolbar.

]
il

The Preferences dialog will display.

(1}

Mastans
Bowwen
Gaenn
Sabery
[

Trsring

Tranns Zones

[ o =

Woram

Radio Network Type

5
!

2 ='§E giﬂis

Communication Sattieas

Communication Setting  Description

Varies according to Radio Network Type

Comms Counter retries

How many data packets are missed before
Comms Error (Blue Subject Status) is displayed

Polling Cycle (ms)

Leave at default 2400 - ECHO network only.
Leave at default 1000 - MotorolaXTS network
only

LoRa Mode

240x15 - 240 BioModules at 15 s refresh rate

Slot Time (ms)

Leave at default 40 - ECHO network only

Leave at default 1800 - MotorolaXTS network
only

Display Unitsin

General Application Settings

Imperial or metric (Height, weight, temperature)

Alarms Audible

ROG Status change audible alerts

Show Comms Events

Comms events recorded in notification area

Show ROG Time

Time in ROG-state displayed on subject status
bar in BioGauge

Refresh gauges every
(seconds)

How often default gauges are repainted. Default
of 0 means after each cycle of device querying

Enable Demo Mode

Enables Demonstration Mode.

Numbers of rows in Event
Log

Max. no. of lines displayed in notification area
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OmniSense™ General Preferences (2/2)

Local PCIP

LoRa Setting

The IP address of the computer running the OmniSense
PC software. The PC may be connected to network though
both wired and wire-less connection and hence will have
multiple IP addresses to choose from the list.

PC Port

The port on which the UDP (User Datagram Protocol)
communication happens with the LoRa Gateway. Valid
rangeis 1024 to 65535. Default value is 1700.

Gateway IP

IP address of the LoRa gateway. The PC application shall
process UDP packets from the configured Gateway IP
address and ignore any other packets.

LoRa Security Key

Security key for the LoRa communication. Used to decrypt
the data packets sent by BioModules and encrypt the

OTA messages sent by Omnisense PC application. Itis 16
characters long.

Gateway timeout
(seconds)

The time PC app should wait if communication between the
Gateway and PC application fails in the middle of an active
session before displaying an error message to the user
saying unable to connect to gateway and connection status
is changed to COMMS ERROR. Valid range between 5 to
1000.

Number of Downlink
Channel

Default value is 8. Valid range is 8 to 64.

Downlink Channel
Separation

Default value is 0.2.

Downlink Spreading
Factor (SF)

Default value is 10. Valid range is 6 to 12.

Downlink Power

Default value is 10. Valid range is O to 20.

Region

Set to US by default.

Heart Rate Recovery Algorithm Settings

The maximum activity level allowed during recovery phase

Upper Activity threshold | (stationary approx.) for the HRR algorithm to auto-calculate
HRR
Lower Activity Threshold The minimum activity level needed (running approx.) before

HRR algorithm can auto-calculate HRR

HRR detection time

Duration during which Upper Activity Threshold must not
be exceeded e.g. sit or lie down during recovery, for auto-
detection of HRR

Show or hide Medic tab

Medic Tab Settings

Makes medic tab accessible during Live Mode

Add Medic Tab as default

Sets whether subjects whose status changes to Red are
automatically moved to the Medic tab.

Remove from Team Tab

Automatically move BioGauge to Medic tab after time-out.
‘No’' means BioGauge will be displayed in both Team and
Medic tabs

Medic Tab time-out

Time delay in seconds of Red status before subjects are
automatically transferred to Medic tab

Additional parameters are configurable, dependent on the Radio Network Type set.
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Add New Subject
In the Subject tab of the Setup screens, click the New subject button.

= -

[ . T Morker 1 - i ] |

135438 pm

Note:

There is no Save Changes button - each value is automatically saved as the
field is exited. The same applies when updating values for any existing subject.

Subject Parameters are described in the next section.

41



CONTENTS

ABOUT THIS MANUAL
GETTING STARTED
SYSTEM OVERVIEW

> Setup Checklist

> BioModule Configuration
> Charge Devices

> Radio Network Options
> Set Radio Network Type

> OmniSense™ General
Preferences

> OmniSense™ Live Setup
Overview

> Safety Alarm Limits

> Devices

> Set Garment Type

> Teams
> Barcode Scanner Operations
> BioModule Operation
LIVE OPERATIONS
ANALYSIS OPERATIONS

ANALYSIS IMPACT
PROCESSING

ANALYSIS REPORTS

LOG DATA

OMNISENSE™ WEB PORTAL
OMNISENSE™ MOBILE
OMNISENSE™ TOOLS
BASELINE FITNESS TESTING
FITNESS PARAMETERS
APPENDICES

EULA

SUPPORT

INDEX

SYSTEM SETUP
Subjects (2/3)

Subject Parameters

When a new subject is created, some fields are populated by default values.
These can be left as is, deleted, or edited.

Parameter Description

Name Names in the database must be unique
Age Used to auto-calculate default HR....
Sex Used to auto-calculate default HR,..
Height Used for BMI calculations

Weight Used for BMI calculations

Fitness Level

1-10 10 = elite athlete

Used in Estimated Core Temperature
algorithm

HR.x
(maximum heart rate)

Default is auto-calculated. Determined and
saved when analyzing the results of aramped
maximal fitness (treadmill or beep) test in
OmniSense™ Analysis. Used to determine
Physiological Load weightings and Training
Thresholds.

Default is 80% of HR..... Determined and
HR (Heart Rate) @ AT | saved by analyzing ramped fitness test
(Anaerobic Threshold) | resultsin OmniSense™ Analysis
Used to calculate Training Zone Thresholds
BR (Breathing Rate) Determined and saved by analyzing ramped
o | @AT fitness test results in OmniSense™ Analysis
% HR High Red Threshold for subject status = Red
€ | HR High Orange Threshold for subject status = Orange
(©
< | HR Low Red Threshold for subject status = Red
>
:6_3 BR High Red Threshold for subject status = Red
©
Y | BR Low Red Threshold for subject status = Red
gg(;e Temperature Threshold for subject status = Red
Time in seconds of an inactive subject before
Idle Timeout subject status changes to Red. Designed for
First Responder systems. Disabled by default
Note:

Any single parameter with a safety alarm limit - Heart Rate/Breathing Rate/
Estimated Core Temperature which crosses a safety threshold, will cause the

subject status to change.
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Subjects (3/3)

Subject Parameters (continued)

HR Resting

Parameter Description

Determined by an orthostatic hypotension
(Readiness) test

HR Standing

Determined by an orthostatic hypotension
(Readiness) test

HRV Rest SDNN

Heart Rate Variability (Standard deviation in
milliseconds)

Determined by an orthostatic hypotension
(Readiness) test

HRV RMSSD

Heart Rate Variability (Standard deviation in
milliseconds)

Determined by an orthostatic hypotension
(Readiness) test

Web Email

‘Activated’ when subject has logged in to the web
portal with password sent to their nominated
email account by their account administrator, and
validated their account.
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Safety Alarm Limits

Safety Alarm limits are also called ROG Subject Status Thresholds. They are
indicated by the color (red, orange, or green) of the subject name panel in each
OmniSense™ Live BioGauge.

Impact 0.88 100% 100% 1289.6 Calories

R1

Upper and lower limits can be set for Heart Rate and Breathing Rate. An upper
rate can be set for Estimated Core Temperature.

If any one threshold is crossed, the color of the subject name backgroundin
the BioGauge will reflect this.

Proprietary Zephyr™ ROG algorithm will adjust the thresholds automatically if
the subject is detected as active, based on accelerometer data.

INACTIVE STATE ACTIVE STATE INACTIVE STATE ACTIVE STATE

(HR Max) (HR Max)

! 40 (BR@AT)

100

60 60

40 I 40
6 6
_ ----- —

Heart Rate Breathing Rate

Safety Alarm Limit Defaults

Default values are assigned when a new subject is created. The default values
can be set in the Live Preferences > Safety Thresholds dialog.
Ed Preferences B

Activity kdle Timeout Fled (seconds)
¥ e sbject reenains inasctive for longes than this peviod. mibedt stalus wil change o Red

Stve Lanse
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Devices (1/9)

Add/Edit BioModules by USB connection

1. Connect BioModule to PCin charge cradle.

.
—

2. Select the Setup button on the OmniSense™ Live toolbar.

3. Select the Hardware tab.

4. Select the Add/Edit button.

Add / Edit

5. Select Add or Edit in the Hardware Setup Wizard when it displays and

then select Next.

[ Marduare Sehup Wizard ==

OmniSense Hardware Setup Wizard r
Step1ofs

[ | 2 a 4 ]
Whial do vou want to do?
@ Add hardware to system
Edil enasting hardware

6. Select Zephyr™, then Next.

4 Hardusare Setup Wizard =1

. - —
OmniSense Hardware Setup Wizard ZephyT
Step 20f5

1 3 4 5
Wil kind of hardwane do you wanl o add?
o Zophy

GPS Devices

Pravous et Cancel

7. Select Connection to PC, and Next.

[ Marduare Sehup Wizard ==

OmniSense Hardware Setup Wizard r
Step3ofs

1 2 4 5
Haw die vou wanl Lo add the new hardware?
& Connecbon b

Config e

Prasous. Neod Cancet
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8. OmniSense™ will normally auto-detect the BioModule in a few seconds,
and populate the pull-down item with the device serial# (BHTxxxxx). Use
the Detect button to retry manually if necessary. If more than one
BioModule is connected, select the appropriate device from the pull-
down list of identifiers.

Ed Hardare Sebop Wizard =
. . E—
OmniSense Hardware Setup Wizard
P Feokyr
Stepdofs
1 ) 3 (3] 5
Omace Selection
1. Connect the device to you PC
and wail for detechon of cick Detec bullon
EHT013099 = | Dasact
2 Choose Dewce name Shert Address: 14

24-00%
3 Clearly mark above name on devce

Prasous. Neod Cancet

Enter a value for Choose Device name - this will be the identifier for your
BioModule in OmniSense™ Live. It will appear on the subject BioGauge. If
editing a BioModule already in the database, then the name field will

@ Note:

contain the existing name. Click Next.

When assigning an identifier to a BioModule, the best practice is to use any
preexisting Zephyr™ label (for example, label number 9154-009 indicating
LoRa Start Frequency-Network Address). Alternatively, attach a label to the
front of the BioModule, so that it can be readily identified when attached to a

strap or garment.

9. Thefinal dialog will confirm that the device has been added.

Ed Hardoare Sebup Wizard =
OmniSense Hardware Setup Wizard F
Step 4 of 4

1 ) 3 (3]
Confirmation
o]

& Add or Edil More Hardware
Close Hardware Selup Wizard

OK

Select Add... or Close... as necessary, and OK to complete the process.

10. Repeat as required for additional BioModules.

@ Note:

The LoRa security key for encryption of BioModule data sent to the application
via LoRa is loaded to the BioModule when the BioModule is added to the
system via the USB connection. If the security key is changed in the application
preferences, apply the new security key to each BioModule by placingit in the
charging cradle and following the connection procedure above. The updated
security key is configured as soon as the BioModule is detected over the USB

connection.
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Add BioModules from an XML File

This method may be used to add multiple new BioModules to an existing

system. This saves the effort of adding multiple devices manually.

1. Inthe 3rd dialog of the Hardware Setup Wizard, select Config File, and

Next.

3 Hardware Sebp Wisard =

OmniSense Hardware Setup Wizard r
Step3ofs

1 2 4 5

Haw die vou wanl Lo add the new hardware?
Connection ta PC

& Config fle

Prasous. Neod Cancat

2. The next dialog allows you to browse to the (optional) xml config file

supplied with the system.

Ed Hardware Sebop Wizard ==
OmniSense Hardware Setup Wizard r
Step 3 of 4

1 2 4

Config fle location

Please sekect the configuration file location
A001277 Hardware Configxmi | Browse

Click Neod to Add

Prasous. Neod Cancat

3. Browse and select the file.

@vvl <« Zeph... + OmniSe..

Oganize = [Ef » [ @

| 001277 Hardware Config.xml

4. Confirmation of the added devices will display.

Ed Hardware Sebop Wizard ==
OmniSense Hardware Setup Wizard r
Step 4 of 4

1 ) 3 (3]
Confinmation
o]

& Add or Edil More Hardware
Closa Hardware Selup Wizard

OK

5. Select Add...or Close... and OK to continue or exit.
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Add BioModules from a Database .FDB File

A completely new system may be supplied with a database file which contains
allinformation on devices included with the system. OmniSense™ software
should be installed first, and then the installed database file replaced by the
pre-configured file.

1. Install OmniSense™ software for the system.

2.  Without OmniSense™ Live or OmniSense™ Analysis running, browse to
the location

C:\Program Files (x86)\Zephyr\OmniSense\Database\DbFile

This directory contains two files - EMPTY.FDB is a surplus empty
database created with all fresh installs, and polling. FDB which is the
active database file. It contains Demo data only, in sessions dated year
2001. Set to 2001 the From field in the Filter Session List pane in
OmniSense™ Analysis to access this data.

[E=N o =
@-u-v| « [atabase » DbFile - | 3 | r
Organize +  » 3~ I @
__|EMPTY.FDB
| polling.FDB

3. Rename the existing polling.FDB to fresh_install.FDB or similar. It can
remain in the same directory, and can be recovered if needed.

4. Rename the pre-configured database file to polling.FDB and save it to the
directory shown.

[E=1 EoR (=
@-u-vl <« [atabase » DbFile - | 3 | r
Organize +  » B I @
__|EMPTY.FDE
|| fresh_install.FDB
| palling.FDB

5.  Whenusing OmniSense™ Live to set up your system, all the shipped
BioModules are now in the database and are available to assign to
subjects. They may be edited as if they had been added manually.
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Add GPS Devices
GPS devices are added by

Bluetooth™* connection to the PC. QStarz 818XT

are the only GPS devices supported at this time.

Bluetooth™* must be enabled in the host PC. If enabled, then the Bluetooth™*
symbol will show in the PC System Tray.

1. Poweronthe GPS.

2. Selectthe Add/Edit

button to start the Hardware Setup Wizard, as for

BioModules. Select Add Hardware...and Next.

Ed Hardoare Sebup Wizard ==

OmniSense Hardware Setup Wizard r
Step1ofs

(K0} ) 3 4 5
Whial do vou want to do?
@ Add hardware to system
Edil enasting hardware

3. Select GPS Devices.

Mot Cancet
4 Mardare Sebup Wizard ==
. . E—
OmniSense Hardware Setup Wizard
P Feokyr
Step 2 of 4
1 3 4
Whal kind of hardware do you wanl 1o add?
Zephyy
& GPS Dewvices
Prasous. Neod Cancet
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@ Note:

4. Wait while the GPS is detected. The Wizard will populate with GPS details.

Use the manual Detect button to try again if necessary. Power cycle the
GPS between attempts. A blue LED on the GPS will indicate that

Bluetooth™*is active.

Ed Hardware Sebop Wizard

1 2 4
Dence Selacton

Connect the devics to yow PC
and wail for detechon of cick Detec bullon

Ostae BT 0016881430 = | Dataet

2. Enter a passkey
O00x
3 Choose Device name
GPSBIEXT
4 Claarly mark abovwe Name on deice

=

OmniSense Hardware Setup Wizard r
Step 3 of 4

Prasvous, Nt Cancet

The GPS need not be Bluetooth™* paired to the PC to communicate. The GPS
passkey of 0000 is entered automatically. The GPS cannot be paired to the PC

by USB connection.

5. Label the GPS device according to the identifier you have selected for it.

Label the device accordingly.

Ed Hardware Sebop Wizard

1 ) 3 (3]

Confirmation

¢ SN Qetary BEEXT O016EZ143748 Narme

: '.j

& Add or Edil More Hardware
Close Hardware Selup Wizard

=]

OmniSense Hardware Setup Wizard r
Step 4 of 4

QK Cancat

6. A confirmation message will display. Repeat as necessary.

The 12-character string which is part of the serial number is the

Bluetooth™* MAC Address of the device, normally displayed in the format

XXXX XX XX XX:XX. The characters are hexadecimal, 0-9, a-f.

The letters are not case sensitive.

50



CONTENTS
ABOUT THIS MANUAL
GETTING STARTED

SYSTEM SETUP
Devices (7/9)

SYSTEM OVERVIEW

> Setup Checklist
> BioModule Configuration
> Charge Devices

> Radio Network Options

> Set Radio Network Type

> OmniSense™ General
Preferences

> OmniSense™ Live Setup
Overview

> Subjects

> Safety Alarm Limits

> Set Garment Type
> Teams
> Barcode Scanner Operations
> BioModule Operation
LIVE OPERATIONS
ANALYSIS OPERATIONS

ANALYSIS IMPACT
PROCESSING

ANALYSIS REPORTS

LOG DATA

OMNISENSE™ WEB PORTAL
OMNISENSE™ MOBILE
OMNISENSE™ TOOLS
BASELINE FITNESS TESTING
FITNESS PARAMETERS
APPENDICES

EULA

SUPPORT

INDEX

Assign Devices to Subject

When BioModules and GPS units have been added to the system, they are
available for assignment to subjects.

Warning

Once devices have been assigned in the software, ensure that the correct
subject is given the devices. If not, then the data in the system may be
assigned to the wrong subject. BioModules and GPS units cannot simply be
swapped in the field, without first reassigning them in OmniSense™ Live.

1. Inthe Hardware tab, select the subject to be assigned. They will highlight

blue.
First Name Last Name Garment BioHarness GPS
Zophy—— Domo SIETSE e Moo

2. Click the Assign button.

Assign

3. Adialog will display. Select the BioModule and GPS to be assigned to the
subject and click the Assign button in the dialog. Available devices are
highlighted black as shown in the legend in the dialog.

Select Hardware Components 8
Zephyr Demo M Curent selection
I Atready allocated
W Avaiable
BioHamesses
GPS
E
Selections
[ Gear | [ Cancel |

4. The assigned devices will display in the personnel listing. No GPS was
assigned in this example.

First Name Last Name Garment BioHarness GPS
Zephyr Demo BH3 Side |v 14-009 None

@ Note

The device fields in the screen are manually editable if the device identifiers are
known.

Caution

The same device can be assigned to two different subjects, as long as they are
not members of the same team, or in separate teams deployed at the same
time. When another member of a team is selected, devices already assigned
to existing members of the team will be greyed out for any assigned to existing
members of the team.

If two subjects allocated the same device are assigned to a team after they
have been assigned devices, a warning message will display, indicating an
equipment conflict.
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Manually Pair a GPS

A BioModule can be manually configured to communicate with a GPS. The GPS

MAC address is required.
unless updated manually
GPS) assigned.

Get GPS MAC Address

This is stored in the BioModule after it is powered off,
or used in a LoRa system with no GPS (or a different

When the GPS is added using the Add Hardware Wizard in Live, the detection
dialog shows this address.

3 Hardware Sttup Wizard

OmniSense Hardware Setup Wizard z_’
Step3of4

1 2 4
Davics Salection

Connacl the devica lo your PC
d wail for detecto chck Detect button

0000
3 Choose Devce name
008
4 Clearly mark above nama on devca

Previous: Nead Cancal

You can also detect the GPS usinga PC from Start > Devices and Printers >
Add Device, and show device Properties after it has been added.

Crstarz BLENT Propertaes v

C—

Fams 8751

Mol e

T— Cier

The Address in this example is 00:1¢:88:22:13:23. MAC Addresses are not case
sensitive. Adding a device in Microsoft™* Windows™* does not add the device

into OmniSense™.

Then, using the Zephyr™ Config Tool, enter the MAC Address in the GPS

Device field and Save.

[€3 zephyr contig Toal vi0240

Lo

42V (100%)

Template for Configuring Values

Load from a Template

Save Template Load Template

Update Device List Read Ordy Data Bustooth | Poling | Subyect Info | User Config | Tme | Accelerometer | ECHO
Select Al Select Nane AT Hx Scttean el Network ID BHTO13033 Set Net i
BHT501645 - USB. v1450 Aop Scftware Verson Buetooth User Configuration
] BHTO13093 - USB ¥3001-03:2012 Zephyr  RF Module Fimware Version Discoverable [¥] Connectable ] LEConnectable [¥] White Lis | Update
— Link Settings
HTO120: :
BT IS Lk Trmeout fna) 10000 Ltesign Pecod rne) 3000 Update
980001835k Hardhare Part Number =
th Devicest
Bustooth DevicestoCal - 4 tiess PIN Code

9500.0084 Boot Part Number

5500.0085vEd #op Past Number BT Accese Port 1 ) 5eBT Dev 0
00176950883  Unt MAC Address BT Access Port 2 0 Set BT Dev 1
BH BHT013083 Biuetooth Name BT Access Port 3 00 Set BT Dev 2
T Acce 4

252015, 154118 Date/Tne BT Acozss Port - ETE
BT Access Port 5 0 S BT Devd
s BT Acoess Port 6 0 Set BT Dev 5
BT Access Port 7 0 SetBTDev 6
BT Access Port & 0000 S BT Dev 7

A poon oo o BT

AR Set BT Dev 9 I
e
Reset to Cal Frendly Name PIN Code Class ID
Delete Log et | | Factory Defauts BT Devies 0

Bokamess Message NAK SetBH
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OMNISENSE™ WEB PORTAL
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OMNISENSE™ TOOLS

BASELINE FITNESS TESTING
FITNESS PARAMETERS L4 Enter team name =)

4. Enter the team name in the dialog displayed.

APPENDICES Teamname  Team 4
EULA [
SUPPORT
INDEX

ok | [ cancel |

5. Anew entry (“Team A’ below, highlighted in blue) will be created in the
right hand panel.

6. To editateam name, select the team in the right-hand panel, and click the
Edit button.

7. Toremove the team, select it and click the Remove button.

Note:

When a team is removed from the system, all members are returned to the
personnel pool. No subject data is lost. In OmniSense™ Analysis, subjects are
then listed under the node ‘No Team Assigned’
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Populate Teams
Add Subject

1. Inthe Team tab, select both the subject in the left panel, and the team in
the right. They will highlight blue when selected.

|4 OmniSense v5.1.0 =1 =8 =

& H.H Recording E E K Lve M| Marker 1 ~ el Lzl A; hcd

Last Name

Athlete3

Athlete?

Athlete1
Zephyr Demo

Select Team And Subject To Move

B L ———
= wm

N N

Offfma 15:40:12 PM

2. Click the arrow button pointing to the Team panel.

-

3. The subject will be added to the selected team node.

= T_eam A

& Demo Subject 1

Remove Subject

1. Select the subject.

= Team A

g Demo Subject 1

2. Usethereverse arrow to remove the subject.

=

3. The subject will return to the Personnel panel on the left.
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Deploy Team

The final stage in preparing for a Live session is to deploy a team or teams.

1. Select the Setup button on the OmniSense™ Live toolbar

*

==

2. Select the Deployment tab

3. Select the team(s) to be deployed from the Teams pane, and a vacant tab
from the Tab A/B/C/D array. A maximum of four teams can be deployed.

4 Omnense 510 -z ]
- g

¥ had b s (O R0 [l e "l Marker 1 -l )i i

e 15:43:59 PM

4. Click the arrow button pointing to the team array.

=

5. The A/B/C/D tabs will populate with the deployed teams. In addition, a
series of Team and player tiles will display on the right-side panel.

= |

e 15:43:59 PM
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6. Tilesdisplayed to the right of the setup tab will appear black until radio
communication with the deployed BioModules has been established. To
establish communication, click the Live button. Once connected, tiles will
display subjects’ red/orange/green status.

-

7. Onceradio communication and subject status have been established, the
subject tiles will be active.

| b4 Omnsense 410 S =5

A had b s ) K] B e 3 merker1 - g 520 Lllial

( Goalkeeper ‘
[ ] _
{"_ﬁfense '
L

L]
|
L
|
[
[l
B
B
m
[}
m
Ll
=
L]
L]
L

T

o

Ofime. 15:47PM / 00:00:25

8. The purpose of the right-hand tiles is to allow a user to maintain some
oversight of subject status while using the Setup tab to make changes.

Un-deploy a Team

1. Toun-deploy ateam, select the team tab and use the arrow button
pointing back to the Teams pane.

2. Theteam will re-display as available in the Teams pane.
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Barcode Scanner Operations (1/3)

Print Pick Lists

Using a supported Motorola™* Barcode scanner, devices can be rapidly
assigned to subjects in the field by scanning barcode labels on the devices,
or from printed pick lists which can be generated by OmniSense™. The host
PC will need to be connected to a printer to generate these. All subjects and
devices must already exist in the OmniSense™ database.

1. InOmniSense™ Live Settings > Subject tab, click on the BRAT (Barcode
Rapid Assignment Tool) Launch button.

BRAT

Note

The BRAT items will only be visible in the Setup Subject screen if the
Motorola™* Drivers have been installed. Refer to Getting Started > Software
Installation.

2. Select Print Barcodes from the displayed dialog.
Barcode Rapid Allocation Tool (BRAT) =

Barcode Scanners

| Show Audit Log |

| Show Scanners |

| Close |
3. Choose from the options. Each button press will generate a letter-size

PDF file which can then be printed.
Bar Code Pick List Printouts =]
Print Barcode Pick: List

| Print All Subjects |
| Print A1l Bio-Modules |
| PintArGes |

| Print Team Rosters |

| Close |

4. The Print Team Rosters button will generate a listing of all teams
(separate page for each team), with subject and currently assigned
devices adjacent.

X
!ﬁ% Team Roster

Start BRAT Go Live
Generated on: 09-Nov-18 11:21 AM

TEAM: Zephyr
Subject BioModule GPS

Zephyr Demo BHT013099 GPSO01
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[T = o]

+ receses [0 5] (] e -4 Markar 1 - it =22

FITNESS PARAMETERS 3. Scanthe Start BRAT code on any of the printed pick lists.
APPENDICES
EULA
SUPPORT
INDEX
Start BRAT
4. The BRAT dialog will launch.
["W'M ...... E
Pert Barcodes B :»k':-..axl-_wl
B Modie
Tost Eove

As codes are scanned for team, subject and devices, the fields will
populate. To change an assignment, simply re-scan with another barcode.

Each time a new subject is scanned, the device fields will empty.

@ Note
Consult the scanner User Manual for correct operation and troubleshooting.
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5. Scantheteam, subject and device code in succession..

!

2-6inches

A !

!'-.ln TEAM:Team 1

6. Approved DoD ID cards are supported.

e T iE

% PERSOH T Subjest & 14 008 GRSAXTO00T
i'l—

The fields in the BRAT dialog on screen will populate as components are
scanned successfully. If a wrong code is scanned in error, just re-scan the
correct code.

7.  Whenall scanning is complete, scan the Go Live code on any pick list, or
select the Live buttonin OmniSense™.

Start BRAT
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Power On/Off

Power On

1. Pressthe center of the BioModule to power on; this will operate a
microswitch inside the device.

2. LEDs willilluminate according to the BioModule configuration.

3. Snap the BioModule into its receptacle in the Zephyr™ strap or garment.
The orientation of the contact studs in the receptacle will confirm correct
orientation.

Note

Best practice is to power the BioModule on while it is being worn by the
subject. This avoids invalid data being transmitted by or logged on the device.

Caution

Long-term use of the BioModule may cause the contact springs on the rear of
the device to become slightly depressed. This can cause poor contact with the
garment receptacle contacts, particularly when the subject is active. A regular
visual inspection is recommended.

If a spring becomes depressed, very carefully lift it up. When this is done,
check that the spring does not protrude excessively, and that the BioModule
can be inserted into a charge cradle without damaging the contacts. Take care
when doing this, to avoid damaging the spring contact.

Power Off

1. Pressandholdthe center of the BioModule until all four LEDs illuminate
briefly. The device will power off.
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Unlit
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log

to configured enabled
GPS
Orange More than 30% | Transmitting, less | Lessthan 10%
9 battery than 30% battery battery
Garment worn, HR detected Not worn
no HR detected
Error Logging Logging not
enabled
BioModule Charging
Constant Flashing Unlit
Error Connected Disabled
(possible if
OmniSense™
Live is running)
Orange Battery fully Battery charging No power
charged connected
_ Always off Always off Always off
Error Downloading a No records/

finished
downloading

@ Note

During upgrades, red and green LEDs will flash alternately while device
application software is being updated; blue and orange LEDs will flash
alternately while LoRa module firmware is being updated. Not all upgrades
include a LoRa module firmware update.
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5. Adjust shoulder strap for minimal tension if used. Its function is to
prevent strap slippage when worn under equipment which makes it
awkward to access the strap.
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> Set Radio Network Type easily, which involves pressure from the front and the rear of the receptacle
> OmniSense™ General simultaneously.

Preferences

> OmniSense™ Live Setup 1.  Grip holder by edge of flat surround next to the notch. Pull the BioModule

Overview gently by the notch - the greater pressure is applied to the rear.
> Subjects

> Safety Alarm Limits

> Devices

> Set Garment Type

> Teams

> Barcode Scanner Operations

PULL
LIVE OPERATIONS GENTLY

ANALYSIS OPERATIONS

ANALYSIS IMPACT 2. Pressthe holder firmly from the rear to pop the BioModule out.
PROCESSING )

ANALYSIS REPORTS

LOG DATA

OMNISENSE™ WEB PORTAL
OMNISENSE™ MOBILE
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APPENDICES
EULA
SUPPORT
INDEX

3.

4. Pressrear of strap with the knuckle of index finger.

-
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> Side Tabs
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> Preferences ) .
2. Power onall GPS units, if used.
> Connection to Cloud Portal
>Demo Mode

ANALYSIS OPERATIONS

ANALYSIS IMPACT
PROCESSING

ANALYSIS REPORTS
LOG DATA

3. Connect gateway to PC via WiFirouter.
OMNISENSE™ WEB PORTAL

OMNISENSE™ MOBILE
OMNISENSE™ TOOLS
BASELINE FITNESS TESTING

WiFi Router

FITNESS PARAMETERS
APPENDICES ‘l l = W uoe
EULA =
SUPPORT t)
LoRa Gateway OmniSense™ PC Application

INDEX

4, Start OmniSense™ Live.

= Subject details and GPS MAC addresses are sent to each BioModule when
Live starts up.
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OMNISENSE™ LIVE OPERATIONS
Startup Sequence (2/2)

OmniSense™ Live Startup Sequence

Immediately on startup, BioGauges will display for each subject, with subject
status indicated by the background color of their subject name pane.

,,,,,, T ——— e 1555PM S 0000:27

The subject status will change through a color sequence prior to any valid data
becoming visible, as communications are established.

Subject Status Color Description

No data yet received - BioModules are being
initialized

Alpha Bravo

Waiting on LoRa connection - Comms Error if
persists

Alpha Bravo

Datareceived - Not Worn indication

Alpha Bravo Valid data

Valid data

Valid data

Startup Times

Feature Approximate Time To Validity

1 to 10 minutes, dependent on number
of BioModules deployed

LoRa Connection

Heart Rate 30 seconds
Breathing Rate 30 seconds
Posture/Activity 5 seconds
Estimated Core Temperature 5 seconds

Heart Rate Variability ~5 minutes (300 heart beats) for SDNN

: ™
(Configurable using the Zephyr 15 seconds for RMSSD

Config Tool)
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Live Screen Overview (1/5)

Live Screen Components

# Component Notes

1 Marker 1

- () =
|| | 05Defender [RO

g

ECTemp -
HR BR

1574 37

lnmg.luml 549 lemumol a0y

1E01PM / 000606

1 | Toolbar = Constant on all screens.
5 Subject BioGauge = BioGauge size reduces as number of
array BioGauges increases.
= A separate tab for each deployed team
(maximum of 4). Tab colors reflect highest
level of subject status on tab; Red =
3 Team/Medic/Training highest.
/Safety tabs « Training BioGauges on the Training tab.
= Red status subjects shown on Medic tab.
»  Subject ROG shown on Safety tab.
4 Corpms Message = Toggle on or off from the toolbar.
notification area
Details/Accel/ = Additional information relevant to the
5 | Comms/GPS/ selected BioGauge
Workout tabs g€
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Live Screen Overview (2/5)

Side Tabs

Current Zone:

Aerobic zone

siieiag

09:52
Ne_xt Zo_ng: -
Aerobic zone

Time Duration:

swwop [T

Vertical

Lateral

Workout Note:

lnoyiom

No Error

I 30
[ lker Casillas __Iker Casillas

Accel Comms Workout

Target training

Raw Graphic
>rapnie Streaming GPS zone and elapsed
accelerometer indication of . . .
location time/time
data comms errors ..
remaining
Safety Tab

Training Tab

Medic Tab

Subject BioGauges are shown on Medic tab after their status is Red for a
configurable period (default 30 seconds). They must be removed manually by
toolbar button.
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Live Screen Overview (3/5)

Live Toolbar
5 \Q Recording ﬁ E a Live - L: Marker 1 - G | -; Ga

Item Function

Add subject to/Remove subject from Medic

# — tab. Subject with Red status for longer than 30
seconds (default, configurable in Preferences) are

moved to Medic tab automatically.

i

Switch to Setup mode - communications (if

Q Switch to Live mode - start communications.
G started) will continue in the background.

Start/stop recording to OmniSense™ database.
Default is recording. Text indicates status.

Recording =

Offline (left)/online (right) - connection status
to Web portal and cloud database. Registered
subject’s live data will be uploaded to the portal
automatically. Text indicates status.

Display comms notification area beneath
BioGauge array. Hidden by default.

4

Session name and activate button. The name
will be displayed in Analysis. Useful for filtering
sessions in Analysis. Tick button must be used
whenever name is changed. Default ‘Live’

. /0
Live "

— Marker name and place marker button. Markers
Marker 1 ~ " | will be displayed in OmniSense™ Analysis graphs.
Set for Individual/Team/All subjects using pull
down list next to button.

Activate Demo mode. Virtual data will populate
BioGauges. If any real subjects are deployed, they
will display simultaneously.

Show location data in a Google™* map window.

Show Preferences (Settings) dialog.

Show offline Help window.

-3l FPERR
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Live Screen Overview (4/5)

Recording Logic

= Data must be recorded in Live for later display in OmniSense™ Analysis.

= Recordingis the default state when Live mode is engaged

+— i B WYl

iz 27l i
e ]

177+ 23
48]

Defender |RO

= Live and Analysis modules can be run simultaneously, but data must be
refreshed manually in the Analysis module using the Refresh button.

Session Names
In OmniSense™ Analysis, the session name will be the name assigned to the

session in Live, using the session name button. Sessions default to ‘Live’,

1. Setthe session nameinthe Live toolbar.

Recording =

2. The session name will appear in the Select Session pane in OmniSense™
Analysis.

7
Orthostatic Hypot: - hal

Select Session
=20 Team A

: Demo Subject 1
(@) Live [13 Nov 2018 - 11:07:12)/ [00:16:16]
A?) Live 1113 Nov 2018 - 11:27:08]/ [01:40:27]
) Live 1113 Nov 2018 - 12:27:36]/ [00:04:29]
@) Live [13 Nov 2018 - 13:32:17]/ [00:02:40]
¥ & Crinostatic Hypotension Test/[13 Nov 2018 - 13:40:22]/ [00:06:10]
@) Live 1113 Nov 2018 - 12:46:48]/ [00:02:51]
—-{_]) Dema Subject 2

Drag Up to 16 onto Legend

3. Forfastaccessin OmniSense™ Analysis, the session name can be
selected in the Filter Session List.

Filter Session List

Show Teams:
(Al -

Show Sessions:

|Drthostatic Hypotension v|

From:
13 Mov 2018, 00:00  [E-
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Live Screen Overview (5/5)

Multiple Recordings

Each time the Record button is pressed in a continuous session in the Live
Module, a new individual subject session is created in the database for each

subject deployed.

Recording n Stopped I 9 I Recording u
Select Session Drag Up to 16 onto Legend
5.2 Team A

4.0 Demo Subject 1
() Live /12 Nov 2018 - 11:07:12] / [00:16:16]

----- @ Live /[13 Mov 2018 - 11:27:08] / [01:40:27]

() Live /13 Nov 2018 - 13:27:36] / [00:04:29]

----- @ Live /[13 Moy 2018 - 13:3217] 7 [00:02:40]

@ Live /[13 Mov 2018 - 13:46:48] / [00:03:51]

El

# Description

1 Multiple sessions created by repeated Stop/Start recordingin
OmniSense™ Live

2 Session Start Time in hh:mm:ss format

3 Session Duration in hh:mm:ss format

4 Session Name

Sessions can be renamed in OmniSense™ Analysis
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3
%HR MAX 36 100%» 100 O Load-P
7

> E.C.Temp 99.0

HR BR
66 . 16

Z ( Iz) 13 _|||I 10
Demo Subject 1

The standard BioGauge displays a number of subject physiological parameters,
and updates at 15-second intervals.

# Description

1 | Subject name. Background color shows subject ROG status.

BioModule identifier as stored in database.

BioModule battery level.

Configurable sweep scale & numeric value, defaults to heart rate.
Configurable field 1.
Configurable field 2.

No data stopwatchicon 4 x 1 minute quadrants.

Configurable field 3.

O N[O UL | D W N

Configurable sweep scale & numeric value, defaults to breathing rate.

10 | Radio Signal Strength indicator.

11 | Timein current ROG Status in minutes. Resets when status changes.

12 | Posture indication. T =upright subject.

13 | Activity Level. (1) = walking equivalent, ((1)) = running equivalent.

14 | Red cross indicates BioGauge also displayed in Medic tab.
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BioGauge (2/4)

Training BioGauge

L emo Subject 1

et 9.9

0.6
Loadp LOad-T

#  Description

1 | Subject Name.

2 | Configurable field 1.
3 | Configurable field 2.
4

5

Configurable field 3.

Tile background color shows the subject's current Training Zone.

= The Training BioGauge is used in the context of a Workout. Once a Workout
has been enabled using Live Preferences, and then selected from the
Session Name list, it becomes active.

= Inthe Workout side tab, two Training Zone segments are displayed - the
current and next segment.

= The subject should work out as prescribed by their coach, and attempt to
match their training zone color with the target zone color in the Workout
tab.

= Training Zone color is determined by the subject’s heart rate. The zone
thresholds are configured in Live Preferences.

| it et 12 - =]

+ Etd = BB i oeass - Marker 1

Demo Subject 1

e 9.9

06 e —
Load.p LO@d-T Aerobic zone

Time Duration.

LEATPM f D0:41:44.
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Speed_HuReq
Ditance_Hwfieq
Blevation_HwReg

OMNISENSE™ WEB PORTAL
OMNISENSE™ MOBILE

Live |Training

OMNISENSE™ TOOLS Save Conca
BASELINE FITNESS TESTING
FITNESS PARAMETERS = Thedialog defaults to the standard BioGauge. Each configurable field has
RS an associated pull-down menu. Select from the options (listed next page)
EULA = Save when configuration is complete.
SUPPORT
INDEX Configure Training BioGauge
» Inthe same dialog, select the Training tab. Three configurable fields are
available.
4 Preferences.

Make

Safity Thrsshesds

Somed Jonwn.

Workouts

Live | Training

Save Cancel

= Save when configuration is complete.

Note

BioGauges can be reconfigured while a Live session is running. The fields
displayed on the BioGauges do not affect what data is sent to the database.
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BioGauge (4/4)

BioGauge Parameters

A variety of parameters are available for configurable fields in BioGauges.

List ltem Description

HR Heart Rate

BR Breathing Rate

HRV Heart Rate Variability
EstCoreTemp Estimated Core Temperature
Impact Peak g of impact event
Activity Peak activity VMU (g)

Calories Burned

Calories Burned (Heart Rate based)

HRMaxPercent

Percent of subject maximum heart rate

HRatATPercent

Percent of heart rate at Anaerobic Threshold

PhysIntensity

Physiological Intensity

Mechintensity

Mechanical Intensity

Trainintensity

Training Intensity

PhysLoad Cumulative physiological load

MechLoad Cumulative mechanical load

TrainLoad Cumulative training load (Avg. Phys + Mech)
Jump Jump event peak g

Explosiveness

Dash event peak g

Stress

Stress Level1-10

Speed_HwReq

GPS Speed over ground

Distance_HwReq

GPS total distance traveled

Elevation_HwReq

GPS elevation above mean sea level

ImpulseLoad

Cumulative impulse load

WalkStepCount

Count of walking steps

RunStepCount Count of running steps
BoundCount Count of bounding steps
JumpCount Count of jump events

Minorlmpacts

Count of minor impacts

Majorimpacts

Count of major impacts

AvgForceDevRate

Average force development rate of step impulses

AvgSteplmpulse

Average step impulse

AvgStepPeriod Average time between steps

FlightTime Time in air during a jump event

PeakMagniPhi Peak magnitude phi angle of impact (from vertical)
PeakMagniTheta Peak magnitude theta angle of impact (heading)
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Side Tabs (1/14)

@ Note

Details Tab

Heart Rate
Temperature

;nosuoml Sdo lswwool |92y

9 Demo Subject 1 :|

= Values are for the selected BioGauge

# Description

Subject/BioModule Parameters.

Cursor values on graph. Mouse over the graphs for numeric value.
Subject ROG Status.
Heart rate 0- 100% HR....of subject.

Activity Level. Cursor value = Flat/Stat/Walk/Run.

Estimated Core Temperature. Set °C/°F in Preferences.

Buttons set graph horizontal scale to 5/10/60 minutes.

1
2
3
4
5 | Respirationrate O - 70 breaths per minute fixed scale.
6
7
8
9

Subject name and ROG status.

The Heart Rate Confidence level in the Subject Parameters section is a useful
indication of the validity of the HR data. If this value drops below 20% the heart
rate is considered invalid and will show '--".

Check strap tension, that the strap sensor pads and skin are adequately moist,
and the BioModule spring contacts have not become depressed. Any of these
factors may cause poor conductivity, resulting in a noisy ECG signal. This will
cause the HR to be invalid.
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‘ Sagittal ‘
o | )
0
|_ 8 " Demo Subject 1 |

= Values are for the selected BioGauge

# Description

1 Raw accelerometer values. Min/Max are values from previous 1 second
epoch.

5 Buttons to enable {3 and disable O accelerometer data for the
selected subject. =

3 | Cursor values - float cursor over graphs to display numerical values.

4 | Vertical acceleration. This value willinclude gravity of -1g.

5 | Lateral (side to side) acceleration.

6 | Sagittal (front to rear) acceleration.

7 | Buttons set graph horizontal scale to 5/10/60 minutes

8 | Subject name and ROG Status.

@ Note

The vertical acceleration data is not filtered to remove gravity. If gravity
appears not to be exactly -1 g, it may be that the subject standing or seated
posture does not result in the BioModule being oriented to absolute vertical.

If the subject is lying down, the effects of gravity will manifest in the sagittal
axis.
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no}ioMm]| Sdo

= Values are for the selected BioGauge

# Description

BioModule/Gateway/PC icons. External sensor icon not shown, For
1 | Bluetooth™* Direct systems, only the BioModule and host PC are
represented.

Link indicator. Green = working link, Red X = broken link

Error message icon area

Error message text

o[~ W (N

Subject name and ROG status
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Side Tabs (4/14)

Communications Error Indications

No Error

No Response from Device

= System operating normally

Device Not Worn

= BioModule powered off

= BioModule out of battery

= Outofrange

= Signal blockage or interference

=  Wrong device on subject

= Hardware fault

= Duplicated LoRa Network Address

Gateway Error

= BioModule notin garment

= Sensor padsdry

= Depressed spring contacts on
BioModule

= BioModule or garment fault

= Gateway not connected
= USB connector fault (replace)
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at13

N —
|_ Demo Subject 1 _\

= Values are for the selected BioGauge

#  Description

1 | Currentlocation Latitude and Longitude

Timestamp of current location values

2
3 Historical location values
4

Subject name and ROG status

= Supported GPS and subject assignment is required

= BioModule must be configured to log in Summary and Waveform or
Enhanced Summary and Waveform format
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Side Tabs (6/14)

Workout Tab

Current Zone:

Aerobic zone

Time Remaining:

09:55

Next Zone:
Aerobic zone

Time Duration:

00:39

3 Workout Note:

Sdo | swwop § 229y | siiejeq |

We suggest up to a 10 minute warm-up in the
first HR zone before doing the following
circuit. Repeat the circuit 2-10 times based
on time and fitness level

# Description

1 | Current Training Zone and time remaining

2 | Next Training Zone and duration of next session segment
3 | Workout note

= See the next section for workout operation.
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Side Tabs (7/14)

Managing Workouts

A Workout is a prescribed activity session in OmniSense™ Live with color HR
indications based on Training Zones.

Training Zones are levels of exertion defined by heart rate thresholds. They are
configured in Live Preferences.

1. Openthe Preferences dialog using the Live toolbar button, and select the
Training Zones button

T TG AHRGAT - 100 iR Max

Gacga Semngs
Saiury Thoashoids =TT

Famaty & Losd

Tewrwyg Trrmboin

= reing ool i
[Tememg Zenes >

Somed Jonws.

The defau
industry accepted standards for aemcbic
renms bt arc

HREAT kor n inck

periceming and
beep fes]

Workouts

2. Select the Heart Rate parameter used to determine the thresholds.

Percentage of subject’s HR at Anaerobic Threshold, as
%HR@AT saved in database (default value, or saved from Fitness
Test analysis).

@ THR@AT

Percentage of subject’'s maximum HR , as saved in
%HR Max database (default value, or saved from Fitness Test
analysis).

Default Return thresholds to their default settings

Default Training Zone Thresholds

%HR@AT
Zone Lower Threshold Upper Threshold
%HR@AT %HR@AT

High Intensity

100 109

95 99

85 94
Rest/Recove Less than 84 84
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%HR Max

Lower Threshold Upper Threshold

Zone
%HR Max %HR Max

High Intensity 90
80 89
75 79
60 74
Rest/Recove Less than 84 59

Lower Zone thresholds are editable; when a lower threshold is edited, the
upper threshold of the zone below is adjusted automatically.

3. Toenable Workouts, select the Workouts button in the Preferences

dialog.
4 Preferences ==l
| Frocorfigursd Workouts
General Setings =
—— | EEE R
[Merws || |Ciar E

Session Names Crout 48
Gauge Settings Cireuit 43
— I (e 1]
Safety Thresholds oot 56

Intensty & Load Crout 57

Training Thresholds Cireut 58
Creuit 61

Tr Zon
(ETFEES | ] e
Speed Zones High Intensity 47

High Intensity Day 31
High Intensity Day 32
Hinh Intensity Day X
Notes:
We suggest up to @ 10 minute warm-up in the first HR zone before doing the following
circuit. Repeat the circuit 2-10 times based on time and fitness level
7] Play Audio (Text to Speech) Total Duration- 51.3 mins

Save Cancel
Check the boxes for those workouts to be enabled.

4. When a Workout has been enabled, it becomes available in the Session
Name field in the Live toolbar.

[ |
Circuit 46 Dl

Live

5. Toactivate the Workout, select it in the Session Name field, and click the
adjacent button.

[ ]

]
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6. Select the Training tab at the bottom of the OmniSense™ Live screen.
This displays subject Training BioGauges.

Demo Subject 1

In-t-T 0 ] 6

0
Load-P Load-T

BAsS1PM | O14EST

7. The aim of the workout is to engage in activity, which matches the
background color of the subject Training BioGauge to the background
color of the Current Zone in the Workout tab.

8. InOmniSense™ Analysis, Training Zones may be displayed as background
shading to a displayed session.

[z 18 8 ) 7 i

Usp Hdden | Filber || Export

Real Time @ Clapsed Time

{rWA) dm ey
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OmniSense™ workouts are based on the Paul Robbins Periodization System.

> Startup Sequence

> Live Screen Overview Workout files are stored at C:\...\Documents\OmniSense\WorkoutFiles in the
> BioGauge form of csv (comma separated values) files which will open automatically in
. «
Microsoft™" Excel™*,
> Map Window
) | =m e~
> Session Names & Markers &5 =[ )« Documents » OmmSense » WorkoutFles T3] [ Search Warke. P
> Notification Area Organize ~ Share with + New folder i~ O @
> Preferences Document=libiagy) Arrange by:  Folder ~
WorkoutFiles
> Connection to Cloud Portal {0 Circuit 46.c5v !)HighIntensity Day 3.csv [ HighIntensity Day45.csv @0 Inten
B Circuit 47.csv [ High Intensity Day 32.csv [, High Intensity Day 46.csv . Inten
> Demo Mode Y Circuit 48.csv % High Intensity Day 33.csv i High Intensity Day 47.csv @ilnter
L] Circuit 49.csv [ High Intensity Day 34.csv [, High Intensity Day 48.csv [ Inten
2] Circuit 50.csv @5 High Intensity Day 35.csv [ High Intensity Day 49.csv B Inten
ANALYSIS OPERATIONS
{5 Circuit 56.csv % High Intensity Day 37.csv (14 High Intensity Day S0.csv {15 Inten
ANALYSIS IMPACT {7 Circuit 57.csv | High Intensity Day 38.csv [ Interval Day Lcsv @ Inter
PROCESSING ] Cireuit 58.csv @ High Intensity Day 3.csv (1 Interval Day 2.csv ) Inter
[ Circuit 61.csv [ High Intensity Day 40.csv [ Interval Day 3.csv [ Inter
ANALYSIS REPORTS 2] High Intensity 37.csv @Y High Intensity Day 42.csv B2 Interval Day 4.c5v B Inten
[ High Intensity 47.csv [ High Intensity Day 43.c5v [, Interval Day 5.c5v . Inten
LOG DATA ap v

136 items
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There are 136 separate workout files.




CONTENTS
ABOUT THIS MANUAL
GETTING STARTED

OMNISENSE™ LIVE OPERATIONS
Side Tabs (11/14)

SYSTEM OVERVIEW
SYSTEM SETUP

> Startup Sequence

> Live Screen Overview

> BioGauge

> Map Window

> Session Names & Markers
> Notification Area

> Preferences

> Connection to Cloud Portal

>Demo Mode
ANALYSIS OPERATIONS

ANALYSIS IMPACT
PROCESSING

ANALYSIS REPORTS

LOG DATA

OMNISENSE™ WEB PORTAL
OMNISENSE™ MOBILE
OMNISENSE™ TOOLS
BASELINE FITNESS TESTING
FITNESS PARAMETERS
APPENDICES

EULA

SUPPORT

INDEX

Send Team Workouts from Web Portal

A coach can send a Team Workout from the web portal, as a single workout, or
as part of a training plan.

No color-matching of BioGauge against workout tile is involved - athletes can
see the target loads for the workout displayed, and should attempt to match
those loads.

If a Team Workout has been assigned, it will be available in the Session Names
pull down list on the scheduled date.

LN 1136AM /010053

# Description

1 | Connect the PC application to the web portal.

Select the assigned team activity from the Session Name field, and
enable using the Change Session Name button.

Use the Start / End buttons to manage the activity. Target load
3 | parameters (configured in the web portal as Threshold Settings) are

displayed.

4 The workout tab displays information on current and upcoming
activities.

5 Configure the BioGauge or Training BioGauge to show one or more of
the target load parameters shown in the Workout tab.

6 Select the Team tab to show standard BioGauge, or Training tab for the
training BioGauge as preferred.

Note

The PC session must be connected to the cloud database for workouts
assigned from the portal to become available.

87



CONTENTS

ABOUT THIS MANUAL
GETTING STARTED
SYSTEM OVERVIEW
SYSTEM SETUP

> Startup Sequence

> Live Screen Overview

> BioGauge

> Map Window

> Session Names & Markers
> Notification Area

> Preferences

> Connection to Cloud Portal

>Demo Mode
ANALYSIS OPERATIONS

ANALYSIS IMPACT
PROCESSING

ANALYSIS REPORTS

LOG DATA

OMNISENSE™ WEB PORTAL
OMNISENSE™ MOBILE
OMNISENSE™ TOOLS
BASELINE FITNESS TESTING
FITNESS PARAMETERS
APPENDICES

EULA

SUPPORT

INDEX

OMNISENSE™ LIVE OPERATIONS
Side Tabs (12/14)

Safety Tab

The safety tab displays tiles showing the subject name and time-in-current-
ROG status only, plus the ROG status itself as a background color.

4 OmniSenie 500

& ﬁu Recording a omee Ll 6 Live]

EE

-l Marker 1 [ R
05 .
Defender Defender
T RO

| os [ e T I
|F° Fnrward Forwardl omrd Furwa - |

G1 | c1|

11 15
onva ‘Forwan:l Forward! orward Midﬂelda

Oil a1l

s|fejaq | [ :

Hidﬁelde - idﬁel |@m |

Ofline 14:51PM / 00:01:21

= The color of the tab itself reflects the highest ROG status of any of the
subject’s displayed parameters.

= Ifany subject status remains red for greater than the time limit
(configurable in Preferences, default 30 seconds), a red cross appears on
the tile, and the subject’s BioGauge displays on the Medic tab. The cross
persists after Red status has downgraded, until the subject is manually
removed from the Medic tab using the toolbar button.

03 03

Defende

Gk RO

Defende
jE GO

Safety Thresholds

Safety thresholds are set in the user's record in the Setup > Subject screen.

Humber OF Users 1 Safety Mam Throsholds

]
HR @ HHLW
AT BPM J’lTEFH

mm———

Default thresholds are set in Preferences > Safety Thresholds.

General Settings 2 Default as

Markers Activity Idie Timeout Red (seconds) 300
BR High Red (BFM) 35

Session Names BR Low Red (BPM) 4

Core Temperature High Red 102 6

Gauge Settings HR High Orange (% HRmax) 80

HR High Red (% HRmax) a0
Safety Thresholds HR Low Red (EPM} 40

E Preferences @
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> Live Screen Overview 4 Medic Tab Sd_-tirgs
> BioGauge Show or hide medic tab Show
Add to medic tab as default Yes
> Map Window Remove from team tab No
> Saston Names S METams Medic tab timeowt after (seconds) 30
> Notification Area
The default settings are

> Preferences

= The Medic tabis displayed.

Dermo Mod = Subjects whose status remains Red beyond the time limit are also displayed
> Demotode on the Medic tab.

> Connection to Cloud Portal

ANALYSIS OPERATIONS

= The BioGauge remains in the Team tab.
ANALYSIS IMPACT * Thetime threshold for Red status is 30 seconds.

PROCESSING
The Medic tab displays the standard subject BioGauge.
ANALYSIS REPORTS
LOG DATA | =Bt~ O~k il e ; Marker @@

OMNISENSE™ WEB PORTAL
OMNISENSE™ MOBILE
OMNISENSE™ TOOLS
BASELINE FITNESS TESTING
FITNESS PARAMETERS

=]
il

o 53.7 Load-P| g
2
-

n 42.2Load-P|[ Jump -
APPENDICES
EULA
SUPPORT
INDEX

15:54PM  O0OTT

Ared cross displays in the center of the subject BioGauge to indicate the
BioGauge is also displayed on the Medic tab.

I:rl:l
L
To remove a subject from the Medic tab when the subject status is no longer
red, use the Remove button on the Live toolbar.
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Training Tab

09:58
L. Aol Next Zone: ———
11 Forward 12 Forward Aarnhi ]

mr 62.6 .'..‘, 63.2
Lot Load-T| 2% Load-T

. L}
s
16 Midﬁnlder 18 Midfielder 19 Mi da
m 311 wr 19.6 IEEETE |
| o3e Load-T P E-Et R

LEI0PM 000729

The training tab displays Training BioGauges.

There are three configurable fields on each BioGauge. Refer to the Subject
BioGauge section for details.

The background color for theTraining BioGauge shows Blue/Yellow/Green/
Orange/Red and is not the Red/Orange/Green subject status indication.

Training BioGauge background color reflects the Training Zone of the
subject, which is a heart rate dependent metric, configured in Live
Preferences. Training Zones are explained in the Workout Tab section.

As the workout progresses, subjects attempt to match the color of their
training BioGauge with the color of the current segment of the workout,
indicated in the Current Zone section of the Workout tab.
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> Startup Sequence = Aninternet connectionis required.
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> Side Tabs ’
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> Notification Area =  The Map/Satellite view can be adjusted by dragging the cursor in any
> PETEEEs direction.
> Connection to Cloud Portal = Use the +/- buttons at lower right, or mouse wheel, to zoom in/out on the
>Demo Mode map or satellite view.
ANALYSIS OPERATIONS oy :
ANALYSIS IMPACT | Sl Tres - Heart Rate =3
PROCESSING | ET—T ;
ANALYSIS REPORTS I e ™ | FULL PATH
LOG DATA e e :
OMNISENSE™ WEB PORTAL e o SE
OMNISENSE™ MOBILE o | y =
OMNISENSE™ TOOLS va-m-:m: R 'L-OCATIUN
BASELINE FITNESS TESTING (=== > )
FITNESS PARAMETERS mm:"m . Vo i - o
APPENDICES L sNAlL mnu—1
EULA =
SUPPORT S
INDEX = Inthe window above, non-default settings are used to emphasize trail

features.
Snail Trail

Snail Trail Parameter Description

Select from HR (shown), %HR Max, %HR@AT,
Parameter Pull-down Physiological or Mechanical Intensity, Speed or
Altitude zone, ROG Status or path only.

Color Thresholds Slide buttons to set coloring of snail trail.
Width Sllc.ie l?utton for snail trail width. Extreme left =
trail hidden.
Opacity Slide button for % opacity.
Slide button for time duration [hh:mm:ss] of snail
Length

trail, preceding current location.

Slide button to set background color behind snail
trail. The color will turn from greentored as a
location becomes prevalent. In a circuit run, Heat
Map is always green unless the runner stops and
holds location.

Location Heat Map
Width

Slide button to add distance markers at fixed

Marker Interval .
intervals

Slide button to set marker width. Extreme left =

Marker Width markers hidden
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Snail Trail Parameter Description

Marker Opacity Slide button to set marker opacity

Slide button to set width of path preceding snail

Full Path Width trail. Extreme left = full path hidden.

Full Path Opacity Slide button to set full path opacity

Save Settings Save a preferred setting for repeated use.

Default Settings Return to default settings.

Use the selector on the map to toggle between map and satellite view.

D v — [ERE—

Snail Trail

Heart Rate =
o 8 141 172
— - o o 1 o E—
a Beais Per Minute (aam) 250
Snail Trail Width: § x
.
Snail Trail Gpaciy. 90%

Snal Trail Lengih: 0:45:00
.
Heat Map Widtr: 0 x hidden)

Markers

aber Interval: 0.5 Miles
»
Maker gt 3x 5
°
Warkse Opacity: 60%

Full Path

Full Path Widtn: 1 x

Full Paih Opacily. 100%

Save Sethings | | Default Setings

= ot Use | Repert amap emer

Heat Map
Full Path

I— Heat Map
Current

Y

T Markers T T Locatnon
Snail Trail

A heat map is an additional wider color trace surrounding a subject’s snail trail.

A heat map is an indication of historical persistence at a location. If a subject
remains stationary at the same location, then their heat map indication will
progress from green to red.

On a sports field, if a subject moves returns to the same location repeatedly,
then that location’s heat map indication will progress from green to red over
time.
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Session Names

Sessions can be named in OmniSense™ Live using the toolbar Session Name
field pull-down, and adjacent Change Session Name button to activate the
selection.

. ]
Live " il
Their main purpose is to make it easier to identify and locate specific sessions

in the Select Session pane of OmniSense™ Analysis. Sessions can be renamed
in Analysis if needed.

The default Session Name is ‘Live’, but if all sessions are set to this, then the
session time stamp becomes the only means of identifying a specific session.

Select Session Drag Up te 16 onto Legend
=] Team A

(L1 Demo Subject 1

.| Live /§12 Mov 2018 - 14:42:44] / [01:16:58]
Live /§13 Nav 2018 - 11:07:12] / [00:16:16]
Live /§13 Nav 2018 - 11:27:08] / [01:40:27]
Live /413 Mov 2018 - 123:27:36] / [00:04:29]
Live /13 Naov 2018 - 13:32:17] 1 [00:02:40]
Live /§13 Nav 2018 - 13:46:48] / [00:03:51]
Live /§13 MNov 2018 - 14:20:59] / [01:18:23]
bject2
Live /12 Nav 2018 - 14:42.44] / [01:16:58]
Live /13 MNav 2018 - 11:07:12] / [00:16:16]
Live /§13 Maov 2018 - 11:27:08] / [01:40:27]

Create Session Name

1. Open the Preferences dialogin OmniSense™ Live using the toolbar
button.

it

2. Select the Session Names button, then the Add New button.

B

4 Poefermnces

Seveted S Le

Seve Carrel

3. Enter the session name in the new (blue) session name entry, and click
Save.

Caution

Prescribed Workouts are displayed in the same field as Session Names. If you
create a new session with the same name as a pre-existing workout, then the
workout of that name will be activated when you click on the Change Session
Name button.

93



CONTENTS

ABOUT THIS MANUAL
GETTING STARTED
SYSTEM OVERVIEW
SYSTEM SETUP

> Startup Sequence

> Live Screen Overview
> BioGauge
> Side Tabs

> Map Window

> Notification Area
> Preferences
> Connection to Cloud Portal

>Demo Mode
ANALYSIS OPERATIONS

ANALYSIS IMPACT
PROCESSING

ANALYSIS REPORTS

LOG DATA

OMNISENSE™ WEB PORTAL
OMNISENSE™ MOBILE
OMNISENSE™ TOOLS

BASELINE FITNESS TESTING

FITNESS PARAMETERS
APPENDICES

EULA

SUPPORT

INDEX

OMNISENSE™ LIVE OPERATIONS
Session Names & Markers (2/3)

Session Markers

Named markers can be added to sessions using the toolbar Marker field and
adjacent Add Marker button.

|
Marker 1 "y

The purpose of markers is to indicate specific events (start and stop of notable
activities or tests during a session, etc) in the data displayed in OmniSense™
Analysis.

240
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o BN

Heart Rate (BPM)
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o e
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The markers are not exported when the data is exported from Analysis as a csv
file, though they will appear in graphs exported as image files.

Create Marker

1. Openthe Preferences dialogin OmniSense™ Live using the toolbar
button.
]

2. There are ten default markers. You can Remove these, retain them, edit
by selecting them, or Add New.

L4 Preferences (=3l
oo ] | Frecomfigured Maker Names
| General Settings | — [ Addlew |
Vatker 2 [ Femore
| Session Names | | | Marker3
[Gouge Settngs | | |Merker?
—— | |Metke'5 —
[[sefery Thvesholes | | |, o ‘ 1 ‘
[irtenstydload | | |Marker 7 p—
| Training Thresholds | | |Merker® ‘ H

— Marker 9
| Training Zones | Ve 10
(=g Sonee ] arker

| Speed Zones |
J

[ Warkeuts

| Save || cance

Save the new or edited marker when done.
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3. Theorder of the markers in the dialog is significant. Each time the Add
Marker button is clicked to add a marker to a session, the list
automatically increments to the next marker on the list.

|
s

Marker 2
Marker 3
Marker 4
Marker 5
Marker 6
Marker 7
Marker 8 -

m

4. Inordertore-use the same marker on the list, you must re-select it from
the pull down menu before adding it.

5. There are three options when adding a marker:

Individual Ctrl+I

Teamn Ctrl+T
All Ctrl+ A

Select Individual (selected BioGauge), Team or All (" and ’) all subjectsin all
teams - before clicking on the actual Add Marker button.

6. The elapsed time component of the clock at bottom right of the
OmniSense™ Live window is reset to 00:00:00 each time a marker is
placed.

'15:38PM / 00:00:00 |
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Notification Area

Notification Area

The notification area is displayed using the Show/Hide Bottom Panel button
onthe Live toolbar.

The Notification Area displays a variety of notifications which can confirm the
system is operating correctly, or may help in analyzing system errors.
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e The settings described in the following section do not include those listed in
> Live Screen Overview the table below.
> BioGauge The table shows the section of this manual where they are described.
> Side Tabs E Preferences X
> Map Window EEpAS ‘
" Conmarscation Setigs -
> Session Names & Markers Markers Radio Network Type LoRa
. i LoRa Mode LoRa 240x15
> Notification Area G e Device Time Setting Yes
v General Application Settings
Gauge Settings Display units in Imperial
> Connection to Cloud Portal Safety Thresholds ?:S:.SCT;:‘:EVEMS ::
Show ROG Time Yes
>Demo Mode Intensty & Load Refresh gauges every (seconds) 0
ANALYSIS OPERATIONS Tanng Thestlds | | (00 2000 0 g Y0000
v LoRa Settil
ANALYSIS IMPACT Tranng Zones 192.168.14
PROCESSING Speed Zones PC Port 1700
Gateway IP 192.168.1.2
ANALYSIS REPORTS Workouts Mumber of Downlink Channels 8
Downlink Channel Separation 0.2
Downlink Spreading Factor 10
LOG DATA Daownlink Pzwer ¢ 10
OMNISENSETM WEB PORTAL g:;::;nk Channel Start Frequency 313.1 .
Local PC IP
OMNISENSE™ MOBILE LoRa PC IP Address: IP Address of the PCin LoRa
OMNISENSE™ TOOLS
BASELINE FITNESS TESTING Sae Cance
FITNESS PARAMETERS
APPENDICES . . . .
Setting Described in Section
EULA
A General Settings System Setup > OmniSense General Preferences
INDEX Markers Live Operations >Markers
Session Names Live Operations > Session Names
. Live Operations > Subject BioGauge > Configure
Gauge Settings . P g d g
BioGauge
Safety Thresholds | Live Operations > Safety Tab
Training Zones Live Operations > Workout Tab > Managing Workouts
Workouts Live Operations > Workout Tab > Managing Workouts

Which preferences are available may vary according to the Radio Network type
selected.
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Intensity & Load
Intensity is an instantaneous measure of effort.

= Physiological Intensity is a measure of cardiovascular output, based on
heart rate.

* Mechanical Intensity is a measure of musculoskeletal output, based on
accelerometer data.

= Training Intensity is the arithmetic mean (average) of physiological and
mechanical intensities

Equivalent Loads (Physiological, Mechanical, Training) are cumulative totals of
intensity values, and reflect the total effort over an activity session.

Intensity is measured on a scale of 1 -10, with no units. These values indicate
zones between absolute Low and High limits which are configurable in
Preferences > Intensity & Load.

Intensity & Load

Low Limit {0) High Limit (10}
Physiological Intensity 50 %HR Max 100 %HR Max
Mechanical Intensity 05 Peak G/epoch 3 Peak G/epoch

Physiological Intensity

Default Physiological Intensity Zone Thresholds

Intensity Low (%HR max) High (%HR max)
Null (no value) Below 50
1 50 54
2 55 59
3 60 64
4 65 69
5 70 74
6 75 79
7 80 84
8 85 89
9 90 94
10 95 100 or above

Intensity values inside a zone are calculated arithmetically. For example, a %HR
max value of 52 equals an Intensity of 1.5.

If Low and High Limits are changed, then Intensity zone limits will adjust to
allow 10 equal intensity zones between the new low and high limits.
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The graph below shows the default Low and High Physiological Intensity limits
and how the ten intensity level zones are distributed between these limits.

PHYSIOLOGICAL INTENSITY

HR max

=

50% HR max

Y

HEART RATE

PHYSIOLOGICAL LOAD
=AREA UNDER CURVE

Physiological Load is the per-second accumulation of the Physiological
Intensity values, and can be represented by the colored area under the
intensity/heart rate curve.

Note that for these limits, a heart rate of below 50% HR max - uncolored - has
no (null) intensity value, and will not contribute towards a load value. The load
value is the total colored area below the trace.

The second graph shows the effect of increasing the lower Physiological
Intensity limit to 75% HR max. The ten zones are narrower.

PHYSIOLOGICAL INTENSITY

HR max

75%HR max

HEART RATE

PHYSIOLOGICAL LOAD
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The corresponding Physiological Load is also reduced, as the same heart rate
trace results in lower assigned Physiological Intensity values.
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